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Introduction 
 
More agencies are transitioning to a paperless office.  This means that all documents are scanned and 
then linked to a client within their agency management system along with supporting materials such as 
digital photos.   FSC Manager offers two options to help agencies become paperless:  E-filing and 
Imaging.   
 
E-filing is the electronic version of transactional filing.  E-filing and transactional filing both have the user 
filing documents by date rather than by customer name.  To successfully use E-filing, the user must 
Tranlog all document handling activity on the client record in FSC Manager.   At the end of the day, all 
documents will be filed in a date folder.   To retrieve the document, the user must reference the date of 
the corresponding Tranlog.  This option generally saves time because all documents are placed in a 
single date folder rather than having to individually attach them to a client file.  However, it is more time 
consuming to recreate the client file because client documents are stored in separate date folders. 
 
Imaging is similar to traditional client filing.  The scanned documents or digital pictures are attached 
directly to the client file.  To retrieve the documents, the user simply opens the client record and clicks on 
the Imaging button and will see all documents pertaining to this client.  Although this option takes more 
time up front to attach the documents, it is easier for users to retrieve the documents because they are all 
linked directly to the client file. 
 
FSC does not have any specific requirements for scanners or digital cameras.  The equipment used in 
the agency should be decided with the assistance of a hardware vendor. 
 
This section will provide the details on how to attach and retrieve images and documents through the two 
methods available in FSC Manager.  Some agencies use one method exclusively while others use a 
combination of both.  In either case, it is up to each agency to decide which method will work best for their 
office. 
 

E-filing 

How to E-file a Document 

1. Create a Tranlog for each document. 

2. In the Tranlog, mark Yes for Paper to File.  This is an important reference indicating that there will be 

a scanned document related to this Tranlog. 
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Figure 1: Tranlog Recorder 

 

3. Scan the document into the unfiled folder:  W:\IMSWin\Serverdata\EFile\Unfiled 
 
NOTE:  The drive letter will vary depending on each agency’s drive mappings.  If this folder does not 

exist, the user must create it.  Most scanners will allow users to set a default directory.  If E-filing, this 
should be the default directory. 

Something to Consider:  Will documents be scanned individually into separate files or as a group 
into one file?   
 
If scanning individually, it will be important to use a standard naming convention.  For example: 
Johnson, James – 09-18-07 auto renewal.pdf 
Smith, Ronald – 09-18-07 auto change.pdf 
 
Some agencies simply alphabetize the documents for the day and scan them in as one file.  
Usually, the document is named by date:  2007-09-18.pdf.  If opting for the single document in a 
PDF format, the user should have Adobe Acrobat Standard or Professional to extract pages when 
emailing. 
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Figure 2: Unfiled Folder Location 

 

4. At the end of the day, go to Tasks on the Banner. 

5. Expand the EFiling tasks and run the Process Daily Efiles task.   

 

 

Figure 3: Tasks 

 

This task moves all of the unfiled documents for the day into a date file for today’s date.  (i.e. 
W:\IMSwin\Serverdate\EFile\2006\Sep\18)  
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Figure 4: E-filed Folder Location 

How to Retrieve an E-filed Document 

1. Open the Client record in FSC Manager. 

2. Highlight the Tranlog related to the scanned document or image. 

3. Click the E-file button on the taskbar on the Client screen.   

 

 

Figure 5: E-File Button 

 

4. This will open the date folder that corresponds to the date on the Tranlog.  Scroll through the 
documents to find the correct image or document.  Highlight or double click to view the 
image/document on the right hand side of the screen.   
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Figure 6: Image Viewer 

Imaging 

Setup Requirements 

Before attaching images, it may be necessary to create a default directory where attached images will be 
stored.  Then make sure the System Defaults point to this directory. 

1. In Explorer, open the network drive letter.  Go to ?:\imswin\serverdata.  If a folder called images does 
not exist, create this folder (Right click->New->Folder.  Name the folder Images).    
 
Some agencies have given their default images directory another name or have their images stored 
on different drive letter than their FSC Manager.  That is acceptable. 
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Figure 7: Images Folder Location 

 

2. Set the Attached Images default path in the System Defaults. 

a. Click on the System button on the Banner. 

b. Click on the System Defaults tab. 

c. Under Attached Images Directory, the path should display?:\IMSwin\Serverdata\Images.  
Note:  The ? designates the network drive letter.  This will vary by agency.  The 
default directory should point to the folder created to store the images.  

d. If the path is not displayed, browse to select the path.  Click on the ellipses next to the 
line, under drives find the network drive letter.  In the directories window, double click on 
the IMSwin folder, double click on serverdata and then double click on images.  Click OK 
and the path will now be displayed. 

 

 

Figure 8: Image Directory Path 
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Creating Imaging Categories 

Categories are similar to folders in Windows Explorer.  They are optional.  Over time, the client 
accumulates many images. Categories allow users to keep similar documents grouped together in a 
folder for better document organization.  Each agency will create their list of categories.  Once the 
category list is created, all users will use the same list. 

1. In the Imaging screen, click the Options menu (above the Attach & View tabs). 

2. Select Imaging Options. 

3. Use the green + to add a new category. 

4. Use the green and blue + to add a sub category to a category already created. 

5.  

 

Figure 9: Image Category Setup 

 

5. To delete a category or subcategory, highlight the category name and use the red – to delete it. 

6. To uncategorized the images in a category, click the button next to the red -. 

7. The last button on the right, allows users to print a report of all the images in a category. 

8. Click OK to save changes or Cancel to leave without saving changes. 

Imaging User Options 

User Options are designed to allow users flexibility in preferences.  Each user can determine his/her 
individual settings.  These options are located in the Imaging screen under the Options menu ->Imaging 
Options->User Options tab. 
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Figure 10: Imaging Options 

 

 

Figure 11: User Options Tab 

 

The options are as follows: 

Tranlog 

Automatic – a Tranlog will be created and saved automatically when the user attaches an image. 

Prompt – a Tranlog will be created automatically when the user attaches an image, but the 

Tranlog recorder will display so the user can change the category or add to the Tranlog before 
saving. 
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File Naming Convention 

When a digital photo is taken or a document is scanned, the image is assigned a name (i.e. mvp-001.jpg 
or document001.pdf).  Some users will assign the name during the scanning process.  Others will assign 
the name in Windows Explorer.  FSC Manager gives users three choices on image file names: 

Don’t Change – do not change the name of the image file (i.e. 1557 Lincoln Ave.jpg).  Keep the 

current image name. 

 Prompt For – ask the user what file name to use when attaching the image. 

FullName – Description – allow the system to automatically change the image file name to the 

client’s full name and the description of the image (i.e. Smith, John – front of house.jpg). 

Print Agency Header 

When this option is check marked, the system will print the agency and client information at the 
top of the image. 

Expand Categories on Open 

When this option is check marked, the screen will display all images in all categories.  If this 
option is not check marked, the imaging screen will display only the categories, not the individual 
images.  The user will have to click on the + to open the image folder. 

Always prompt for security when attaching an image 

This option will prompt the user to assign life, health or securities settings to every image they 
attach.  Recommended for licensed users that spend the majority of their time doing life, 
health, or securities related work.   

How to Attach an Image 

There are two ways to attach images: from the Images button on the Banner or directly from a Client 
screen.  If attaching images for a group of clients use the Images button on the Banner.  If attaching 
images for one client, use the button on the client screen. 

How to Attach an Image from the Banner 

1. Click on the Images button. 

2. In the Imaging area, browse to the folder where the images are saved. 

3. The bottom window will show all of the pictures and scanned documents in the folder.  Highlight the 
image that will be attached.  It will preview in the right hand window. 
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Figure 12: Image Viewer 

 

4. Click the Attach Image button at the bottom of the screen. 

5. At the top of the locater, indicate if the image will be attached to Clients or Apps 

6. Select a client and/or policy that the image will be attached to and click Assign.   
Note:  If a client’s name does not appear in the locater, click the Refresh button. 

7. Enter the description for the photo or document and click OK.   

 

Figure 13: Image Name 
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8. If prompted, select a category for the image and click OK. 

 

 

Figure 14: Image Category 

How to Attach an Image from the Client Screen 

1. In the Client screen, click the Images button on the toolbar. 

2.  

 

Figure 15: Images Button 

 

2.3. On the Attach tab, select the drive and directory where the images are saved. 

3.4. Highlight the image from the list of images in the bottom left window.  The image will preview in the 
right window. 

4.5. Click the Attach Image button. 

5.6. Enter a description for the image and click OK. 

6.7. If prompted, select a category for the image and click OK. 

Drag and Drop 
In the 10.0 update FSC Manager began supporting the drag/drop feature to allow attaching of images.  
Files can be dragged and dropped onto the Client or Imaging screen to launch the image attaching  
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process.  If the image is dropped on a specific policy on the Client screen, it will associate the image with 
that policy. 

If FSC Manager is on ASP, Citrix or Terminal Server, users will only be able to drag and drop 
images that are within the Terminal Server/Citrix session. 

How to Retrieve an Attached Image 

1. In the Client screen, click on the Images button. 

2. Go to the View tab. 

3. The client images will be listed in the left window in categories and/or in date order.  The images will 
preview in the right window when highlighted. 

How to Secure an Image 

Users licensed for Life, Health or Securities will be able to secure Images, so that only licensed users 
may view Images related to that line of business.  To set security for Life, Health and Securities see 
Chapter 2 – System Setup.  Non-licensed users will not have access to secured Images. 

Images created in the following ways will be secured automatically: 

1. Attach the Image directly from the  (secured) policy screen 

2. Attach the image from the Main screen at an App level 

To Manually secure a Image: 

1. Open the Image to be secured 

2. Click the Secure icon 

3. Select the security relation and click OK. 
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Figure 16: Securing an Image 

Secure images are encrypted on the hard drive. 

Up Front Imaging 

FSC Manager supports Up Front Imaging.  Up Front Imaging is for agencies that wish to scan in all 
documents and deliver them through the management system.  This feature interacts with Notifications. 

One user must "distribute" the images to the appropriate individuals, through the Imaging screen.  Users 
will receive a Notification that images are available to attach with a link that will launch the Imaging screen 
to attach the images. 

Distributing Images 

1. Open Imaging from a Client screen or the Banner 

2. Highlight one or multiple images 

3. Click the Distribute Image button 
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Figure 17: Distribute Images 

 

4. Select the user(s) to be notified, type a note (if applicable) and click OK 
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Figure 18: Select Users 

Attaching Images 

The images will be transferred into a Notifications directory in the Unattached Images directory.  If no 
Unattached Images directory is specified in System Defaults, the Notification will default to 
?:\IMSwin\Serverdata\UnattachedImages\Notifications. 

The user will receive a Notification that indicates an image is waiting to be processed.  The Notification 
will contain a link for the user to attach the image. 

 

 

Figure 19: Upfront Imaging Notification 

When the user clicks on the link, the Imaging screen will open displaying the images related to this 
Notification.  The user can then attach the image(s).  If the user attaches all images linked to this 
Notification, the Notification will automatically be dismissed. 
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Additional Information  

The imaging screen has additional features.   This section will review the icons as they appear from left to 
right on the top of the image screen.   

 

 

Figure 20: Imaging Screen 

 

 - Unattach Image from Client – puts the image back into the default unattached images directory.  
Allows user to attach it to a new client. 

 - Delete Image – permanently deletes the image from the client and hard drive. 

 - Rename Image File – this renames the image file on the hard drive.  In the example above, the 
image name is located at the bottom of the screen:  Abel, Ethel M. New Home1.jpg.  To change the 
image description, click the description once to highlight it.  Single click again on the description.  When 
the black box appears around the description, type a new description. Click somewhere else on the 
screen to save the changes. 
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Figure 21: Changing Image Description 

 - Assign Image to a Category – allows user to assign the highlighted image to a category. 

 - Uncategorize Image – allows user to remove a highlighted image from a category.  The image 
remains attached to a client, but not assigned to a category. 

 - Print Image 

 - Preview Image 

 - Email Image – this email button will attach the image currently open.  To email multiple images, 
click the Attach button to attach more images. 
 

 - Scan in Image – launches the scanning software to scan a document. 
 

 - Select Scanner Source – locates the scanning software if available. 
 
Additional information regarding the image is provided at the bottom of the screen.  The date that the 
image was attached to the client is located in the lower left corner.  Directly to the right of the Attached 
Date is the Path.  This displays the image file name and the location where this image is stored on the 
hard drive. 
 

Obtaining Support 
 
If you have any questions about this document, please contact FSC Customer Support.  Thank you and 
enjoy using FSC Manager! 
 
West Coast Customer Support: 800-433-2550 
Midwest Customer Support: 800-401-2895 
Email: fscmanagersupport@fscsolutions.com 
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